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Introduction to Windows

Microsoft windows is a family of operating systems for personal computers.
Windows dominates the personal computer world, running almost on 90% of all personal
computers. The remaining 10% are mostly Macintosh computers and LINUX operating
system based machines. Windows provides a graphical user interface (GUI), virtual memory
management, multitasking, and support for many peripheral devices. This chapter will show
you all the basics you need to get started. You’ll get an overview of Windows features, and
you’ll learn how to use Help to get an answer to your questions and find out more about using
windows operating systems.

8.1 Main Keywords Associated With Microsoft Windows

e Disk Drives

Drives are devices used to store data. Most computers have atleast two drives: a hard
drive C:\ (Which is the main means of storage) and a floppy drive (which stores
smaller volumes of data (1.44 Mb) on 3.5" disks - floppy disks). The hard drive is
typically designated the C:\ drive and the floppy drive is typically designated the A:\
drive. If you have an additional floppy drive, it is typically designated the B:\ drive.
A hard disk can have multiple partitions as well. In that case the first partition will be
labeled as C:\ and the rest will be labeled as D:\, E:\ and so on depending upon the
number of partitions. You can also have network drives on your computer, depending
on authorization and rights of eachuser. These drives will typically be labeled after the
hard drives. e.g. H:\ or G:\ ;

e Folders (Directory) ;
Folders are used to organize the data stored on your drives. Think of your computer
drives as filing cabinets. You can sort your data on drives with folders that store
different files. The files that make up a program are stored together in their own set
of folders. You can organize the files you create in folders for better accessibility.
Folders can be copied and moved from one place to another on your hard disk.

¢ File Extensions

File Extensions are the ending letters which are placed after a DOT in the file name
e.g. PhoneNumbers.txt. In this file name, PhoneNumbers is the name of the file and
ixt is the file extension. This extension of a file associates it with an application that
can be used to view and manipulate it. In this way Windows knows which program to
open for a particular file type. For example, a text file has an extension of .txt, so a
text file created in Notepad with the name PhoneNumbers would look like this
PhoneNumbers.txt. You do not have to assign a file extension to a file that you
create. The program you use will automatically do this for you. All you need to do is
give it a filename. Some other common extensions are as follows:

e .doc = Microsoft Word Document
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xIs = Microsoft Excel Document

L
e .ppt = Microsoft PowerPoint Presentation
e .mdb = Microsoft Access Database
e .bmp = Windows Bitmap Picture
® .way = Sound File
e .html or .htm = hypertext document
e Icon _ :
An Icon is a graphic image. Icons help you execute commands quickly. Commands
tell the computer what you want the computer to do. These may be shortcuts to
applications which are installed on your computer. If you want to execute a command _
by using an icon, double-click on it. Below are some of the icons and their uses.
My Computer = My Computer icon provides access to the different parts on
-g your computer. You can access the different disk drives
(Hard Drive, Floppy Drive, and Network Drives) inside My
Computer.
Recycle Bin - | When you delete a file or folder, Windows sends it to the
ey Recycle Bin. You can restore the file or folder that are
’*fz\i located in the Recycle Bin or you can permanently delete
X them by right clicking on the Recycle Bin and select Empty
Recycle Bin. . S
My Documents The My Documents folder is nothing more than a regular
= folder that resides on your Windows Desktop. However, it
@ offers an easy-to-reach location where you can store and
retrieve important data, and the icon is always available in |
Explorer Windows and on the desktop.
Internet The Internet Explorer icon launches the Internet Explorer
Explorer e browser. The Internet Explorer browser is what you will
: use to access the Internet and the World Wide Weh.
8.2 Features of Windows
* Graphical User Interface:
~ Windows provide user-friendly interface to work. Its improved graphical user
interface makes learning and using Windows more natural and easier for all types of
users. It is more stable, customizable and efficient.
e Start Button '
Introduction of START button in Windows made life much simpler while there is a
need to access multiple programs. It is the gateway of accessing most of the
functionality available in the computer loaded with Windows. Just Click on the Start
button anytime to start any programs, open or find documents, change windows
settings, get Help, manage Files, maintain system, and much more.
e Taskbar :

As the name suggests, the Task bar provides information and access to applications
that are being currently run by Windows. Using this, one can keep track of programs
that have been activated and can switch between them.
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e Windows Explorer >
Windows Explorer acts as a directory browser and File Manager for Windows, and
incorporates lots of additional features. It is an efficient, faster and user friendly way
for locating and managing files on your computer. .
Using Explorer one can easily browse through all the drives and network resources
available and manage them.

e Mouse

Although you can use the keyboard for most actions, many of these actions are easier

to perform with a mouse. The mouse controls a pointer on the screen. You move the

pointer by sliding the mouse over a flat surface in the direction you want the pointer
to move. If you run out of room to move the mouse, lift it up and then put it down in

a more comfortable location. Mentioned below are the five basic mouse actions.

« Point to an item: Move the mouse to place the pointer on the item.

e Click an item: Point to the item on your screen, and then quickly press and
release the left mouse button.

° Right-click an item: Point to the item on your screen, and then quickly press
and release the right mouse button. Clicking the right mouse button displays a
glon_cut menu from which you can choose from a list of commands that appl)_\(/ to

at item.

¢ Double-click an item: Point to the item, and then quickly press and release the
left mouse button twice.

o Drag an item: Point to an item, and then hold down the left mouse button as you
move the pointer.

e Shortcuts

As the name suggests, SHORTCUTS establish a link with original programs, these
are the shortest way of accessing files and other resources in Windows. Instead of
traversing the full path of the program to access it, one can create "shortcuts".

e Multitasking
Multitasking allows the user to activate and accomplish more than one task at a time.
For example, work on a document file in WORD programs, while copying file from
other computer available on the network. With Windows computing environment, the
user can do more than one task at a time. .

¢ Easy Internet Access

One of the most useful and entirely new features in Windows is easy access to
Internet. It provides built-in Internet functionality to setup link and access Internet
with fewer amounts of Hardware and Software requirement. It also provides
connectivity software from Microsoft Network (MSN) which allows you to stay in
touch with family and friends throughout the world.

It also improves the efficiency of working on Internet with applications that support
the latest Internet technologies, such as Internet Explorer, Java, and streaming audio
and video support.

¢ Great Gaming Platform

Windows support rich graphics, high quality audio and video. It has all the
functionality incorporated in it to support these technologies. All this is possible
because of Windows compatibility with latest and hottest technologies like Plug and
Play, AutoPlay, and built-in support for MIDI and digital audio and video.
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* Hardware Compatibility

Windows provides greater Hardware compatibility as compare to any other operating
environment. It has flexibility of supporting hardware from different vendors. Its
Plug and Play functionality allows you to insert the hardware card into the computer
and when the computer is turned on Windows automatically recognizes and sets up
the hardware.

* Search Utility

Search Utility of Windows allows you to do searches by partial name, last modified
date, or full text. In addition, you can save, rename, or view files from within the
result pane, just like you can from Windows Explorer.

e Help :
Windows provides online help to accomplish a task. If the user is not sure how to
perform a task, Windows Help will provide structured process for guiding on how to
accomplish the task. Simply right-click on any object in the user interface (icons) and
you'll get relevant descriptions about that object. Help can also be accessed from the
start menu button.

8.3 Windows Desktop

When you start your computer, the desktop is the first thing you see after logging into
the computer. For login you have to give username and password. A common desktop image
shown in Fig.8.1, which shows the screen with icons for various programs. The desktop is the
area where you work.

Icons

Windows

Start
button —————p

— Taskbar

I
Applications running
on the computer

Figure 8.1: Windows Desktop
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8.3.1 Start Button and Taskbar

Windows features the Start button and Taskbar at the bottom of the screen. This
bar contains the Start button. Using this button, a program can be quickly started or file
can be searched for. Quick help on how to use windows can also be obtained from this task
bar. :

Administrator

Figure 8.2: Start menu

Click on the Start to activate the Pop-up menu, click on All Programs to run
applications, use Search button to find a file or folders (directory or sub-directory), Help and
Support button to change the settings for Windows, Run a program using the Run link or shut
down the computer using the Shut Down button at the bottom of the menu.

If you have opened more than one program or windows, you can switch between
them. All the opened windows or program appears on the Task bar as minimized icons as
shown in figure 8.1. Click on the desired icon to open the designated program. Similarly if
you don't need a window too frequently, click on the minimized button of the windows. This
will send the activated window as small icon to the task bar.

8.3.2 Steps to start a program

=+ 1. Click on the Start button, and then point to All Programs option.
2. Select the program you want to run. If the program you want is not on the
menu, point to the folder that contains the program. '
3.  Click on the program icon or menu.
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Flgure 8.3: Starting a program

Once the selected program starts, a small icon appears on the taskbar. If you have

opened more than one programs, click on the required program icon on the taskbar to make it
currently activated program.

If the desired program is not available on the program menu or one of its sabmenus
you can use the Find dialog box to locate the program file.

8. 3.3 Steps to Open a Recently Used Document

1. Click on the Start button
2. Select[pomt to Documents option.
3. Select the document you want to open, by clicking on it

[

v
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Administrator

Figure 8.4: Opening recently used documents
4. The document will be opened in a window.

8.3.4 Steps to Search/Find Files

1. Click on Start button el R —
2. Select Find from the menu : :
The following screen will appear in a window.

Search by any or all of the criteria 1
below.

Al or part of the file name:

?ﬂw phrass in the file:

i
Ew:d Hard Drives (C;D4EF:) i

When was it modified? »
What size is it? »

o+
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The windows can search the file using following options.
1.  Files or Folders .

2.  On the Internet

3. People

4.  Using Microsoft outlook

The appropriate words can be entered into the textboxes and windows will start the
search when you click the search button at the bottom. The Drives on your computer where
the file can be found is also customizable. '

LOOK in: i
de* Local Hard Drives (C:;D:EF:) g |
My Documents ‘

J

N My Pictures |
3 My Music 1\
{

\

Desktop

My Computer
e
% OFFICE C (C:)
% OFFICE D (D:)
e OFFICEE (E:) ‘
S OFFICE F (F2) L
& D Drive (G2) [
3 Browse. .. !
Figure 8.6: Look in Option in Search Window

You can ask the windows to search in a particular drive e.g. C:\ or DA\ or in all the
drives by using Local Hard Drives option. This can be selected from the Look In menu. The
others links available on the search pane can be used for advanced searches.

8.3.5 Steps for Shutting Down and Restarting Windows

1.  Click on the Start button at the bottom left corner of screen
2.  Click on Shutdown Button (on the right corner of the start menu)
3.  The following box will appear on the screen

Shut Down Windows

Windows

rcl Bt

Figure 8.7: Shutting down / restarting windows
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4. Select an option from the pop up menu.

Restart =
Log off Administrator

Restart
Stand by

Figure 8.8: Menu for Shutdown / Restart

8. Click on OK.
6. The system will save necessary files to the disk and then take the requested

actions.

8.4 Using the Windows Explorer Program

Windows Explorer is a program which allows you to view all of your folders, and
files in those folders. It is divided into 2 panes. On the left side are the drives and folders. The
right pane shows the files and subfolders of the folder or drive you have chosen from the left
pane.

@ veston
::; -fi“]mbmmm | - g - e
di—— H OFFICE C (C:) OFFICE D (0:) OFFICEE(E:) OFFICEF (F1)
] % OFFICE D (D:) l
[ %o OFFICEE (E:) ]

# Ga» OFFICE F (F2) ’ Devices with Removable Storage

= D Drive (G:) | y
151 @ Control Panet v &
# My Network. Places

. - €D Drive (G:)

Figure 8.9:‘ Windows Explorer Window
8.4.1 Steps to start Windows Explorer

1.  Click on the Start at bottom left corner of screen
2.  Click on Programs :
3. Select Windows Explorer
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8.4.2 Creating a Folder

You can create afoldcrmputyowﬁies in. The folder can be made in a drive inside
any other folder or as a separate folder in any hard drive. To create a folder, follow these
steps.

1. Select the Drive or Folder you want to create your Folder in

2. Right click in the right pane in the white area

3.  Select New

4. Select Folder

5.  Type in name for that Folder and press enter

Your new folder is ready for use.

8.4.3 Deleting a file or folder

1. Select the File/Folder you want to delete
2. Hit the Delete Key on the keyboard ~
3. Confirm Deletion

Confirm Folder Delete

Figure 8.10: Confirming deletion of files
4.  The folder and the files in the folder will be moved to the recycle‘ bin.

Figure 8.11: Emptying the Recycle Bin
5. They can be permanently removed from the recycle bin by right clicking on the
recycle bin and selecting the option empty recycle bin.

8.44 Copying a File/Folder from a Floppy Disk to Other Drive

1. Select 3.5 Floppy (A:) in the left pane.
2. Select the File/Folder you want to copy from in the floppy drive .
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3. Right Click on the File/Folder and click Copy

Figure 8.12: Copy file option in right click menu--

4.  Go to the destination folder where the file/folder is to be copied. Right click in the
window in the white area

Figure 8.13: Paste option in right click menu

5.  Use the paste option in the right click menu. The windows will show file copying
progress box and it will automatically close when the copying is complete.
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8.4.5 Renaming a File or Folder

e Select the File or Folder you want to rename
e Right Click on it

Figure 8.14: Rename option in right click menu
e Select Rename
* Type in the new name and press Enter button
8.5 Using Windows Controls

All programs designed for use on computers that have Windows installed have
common controls that you use to scroll, size, move, and close a window. The figure below
shows a typical My Computer and some of the common controls available in it.

Figure 8.15: My Computer Window with controls

The table below lists a required task to be performed by a user and then method for
performing the required tasks.
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Required Task

How to perform the task

Move, or scroll, vertically or horizontally
through the contents of a window that

Click a scroll bar or scroll arrow, or drag the
scroll box. Figure above identifies these

controls.

Click the Maximize button, or double-click
the window title bar.

Click the Restore button, or double-click the
window title bar. When a window is
| maximized, the Maximize button changes to
the Restore button.

Click the Minimize button. To display a
minimized window, click its button on the

extends beyond the screen
Enlarge a window to fill the screen

Restore a window to its previous size

Reduce a window to a button on the taskbar

taskbar.
Move a window Drag the window title bar.
Close a window Click the Close button

8.6 Using Windows Menu’s

A program menu provides a list of options from which you can choose. On program
menus, these options are called commands. To select a menu or a menu command, you click
the item you want. .

8.6.1 How to Open and make selections from a menu
1.  On the Desktop, double-click the My Computer icon.
The My Computer window opens.

My Computer I l {

Figure 8.16: My Computer window with Edit Menu i

2. Inthe My Computer window, click Edit on the menu bar.
The Edit menu appears. Some commands are dimmed. This means the command
isn't available. This is because the command is not applicable to the current selection
or option.

3. Click the Edit menu name to close the menu.
The menu closes.

4.  Click View on the menu bar to open the View menu.

5.  Onthe View menu, click List.
The items in the My Computer window now appear in a list, rather than as icons.

NOT FOR SALE - PESRP




Chapter 8 141 Computer 9

6‘

4.

On the View menu, point to Arrange Icons By.

A cascading menu appears listing additional menu choices. When a right-pointing
arrow appears after a command name, it indicates that additional commands are
available.

Click anywhere outside the menu to close it.

Click the Close button in the upper-right corner of the My Computer window to close
the window.

Changing Désktop Background

~ To change the background of the desktop

'

1. Right Click on the Desktop.
2.  Click on Properties

Figure 8:17 Selecting Desktop properties
g In the Box that appears click on Desktop Tab and choose a background.

Figure 8.18: Changing Windows Background
Click on Apply and then click Ok.
Similarly all other option such as Screen Saver and Settmgs can be used from their
respective tabs.
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8.8 Using Control Panel

The Control Panel allows you to customize features such as "Appearances and
Themes" or "Printers and Other Hardware". Additional features guide you further. For
example, if you are downloading pictures from a digital camera for a class project, selecting
"Printers and Other Hardware" provides you with the "Scanners and Cameras” option. By
choosing the category you want, you can complete your task easily.

away.

¥ Contool Hared

Fle Eit Vew Favorites

If you prefer the classic Windows control panel, that option is just a mouse-click

Tods Hep

O 3 Pawe

5‘:} Centrol Pand

Acigtsibiinty Uptions

: i“f’-‘?,;;“.w—”” e

Figure 8.19: Windows Control Panels

Some of the important functions of windows control panels are described below.

Option Task Performed by using the option
Add/Remove This is used to add and remove hardware device drivers for devices such
Hardware as CDROM and DVD drives, 1/O devices (Keyboard, mouse), modems,

multimedia, and network cards. ¥ -

Add/Remove Allows programs to be installed or removed from the system including
Programs optional Windows components.
Administrative Only the members of the Administrators group can use these tools for
Tools making policies and advanced functions.
Display Used for changing Background, Screen Saver, Appearance and Seftings.

Internet Options

| advanced options of internet explorer.

These are options are for Internet Explorer. Used for configuring

Keyboard

For configuring keyboard speed and other attributes

Mouse

For setting mouse pointer and mouse speed
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Printers Allows Installation and Removal of printers from the computer. It can
also be used to search printers from the network.

Sounds and This can be used to setup sound schemes and sounds to play for specific

Multimedia events.

Scheduled Tasks | This is also known as "Task Scheduler”, it is used to schedule programs
to run at specific times. An "Add Scheduled Task" icon is present in this
folder which can be used to add new task.

Game Controllers | Allows configuration of joysticks and game pads for computer games.

Fonts This allows viewing of current fonts and installation of new fonts for
writing text. It is a shortcut to the font’s folder.

Scanners and For installing and configuring Digital cameras

Cameras ;

8.9 Computer Virus and Antivirus
8.9.1 Computer Virus

A computer virus may be a program or a set of programs that can cause extensive
damage to your computer system.

This code is attached to some part of the normal computer operating system or
computer program. Instructions in this code tell the computer to perform some task. This task
is often a destructive one, such as deleting important information or crashing the hard disk.
However, there are other viruses that may only slow down your computer or do no serious
damage. Some viruses have been known to do nothing more than put a large happy face on
your computer screen.

8.9.2 How Does a Computer Get a Virus?

Just as a biological virus is passed from person to person, a computer virus is passed
from computer to computer. A virus can be attached to any file that you copy to your
computer. If you download files from the Internet or copy programs or files on floppy disks,
you are very susceptible to viruses. Whenever you download files or put a floppy disk into
your computer, you are susceptible to viruses.

Many viruses are spread through e-mail. Generally, you cannot get a virus from
simply reading e-mail. Certain types of today's viruses, like Klez, are different. They are very
dangerous because you do not even have to open an e-mail attachment to release the virus.
Just opening the e-mail itself can release the dangerous bug.

Under normal circumstances, a virus becomes active when you execute a program
that contains the virus. For instance, if you download a program from the Internet and it is
infected with a virus, the virus will attack your computer when you activate the program,

8.9.3 Antivirus

Antivirus is software that is used to detect and remove a virus on a computer system.
You can stop viruses before they enter your computer. You can do this by using a
good virus protection program i.e. anti virus software. it will check all files for viruses. Once
installed, an antivirus program can be set to work in the background. It will check all files
before they enter your computer and will alert you if a virus is detected before it contaminates
your system. If a virus is detected, your antivirus program will quarantine or eliminate it so

‘that it cannot harm your computer.
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Be very careful to use a virus protection program that matches your operating system.
If you use a Mac, use a virus protection program made especially for Macintosh computers. If
you use Windows 98 or XP, select a program that was written specifically for your operating
system. Don't try to use a virus protection program that was written for Windows 95 on a
Windows XP machine; this will cause unstable behavior and may cause your computer 0
crash or malfunctions. '

New viruses are written everyday. Companies like McAfee, Symantec, and Panda
Software are constantly expecting new viruses and updating their antivirus software tools.

pras
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S e Exercise
1.  Briefly explain the following:

a. Drives b. Folders ¢. Directory d. File extension e. Icon
2. Name and explain three different features of Windows.
3.  What is start button and taskbar?
4.  Write the steps needed to start a program?
5. What are the steps for shutting down and restarting windows?
6.  What isWindows explorer? How can We start Windows explorer?
7
8

. What is the use of recycle bin?
. What is “Control Panel”? Name three different options of control panels and
tasks performed them .
9.  Write a note on computer virus.
10. What are the benefits of using anti-virus programs?
11.  Fill in the blanks :
(i) Windows dominates the personal computer world, running almost on
% of all personal computers.
(ii) in the file name PhoneNumbers.txt, the part “PhoneNumbers” is the

of the file and “.txt" is the of the file
(iii) When you delete an object, Windows sends it to the
(iv) acts as a directory browser and File Manager for Windows
(v) Windows places the deleted files and folders in
(vi) is just a link to the original file/folder or an application.
(vii) can seriously damage the computer systen.
(viii) Windows is a(n)
(ix) A(n) is a software that is used to remove the viruses from the system.

(x) To add or remove hardware, you must select an option from
12. True or False
(i) A Network is a group of Computers connected to each other to share available
resources such as storage and printers.
(ii) Windows do not provides online help. . :
(iii) Multitasking allows the user to activate and accomplishmore than one taskata time . _
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(iv) Folders are used to organize the data stored on your drives.

- ) Icons help you to remember file names in windows.
()  The Internet Explorer browser is what you will use to access the Internet and the
World Wide Web.

(vii)  Windows is just a GUI, not an operating system.

(viii)  shift + ctrl + delete command sequence is recognized only by Windows.
(ix)  Contents of Recycle bin can be restored to.

(x) NORTRON antivirus software can detect all viruses in the computer.

13.  Choose the correct answer
the gateway of accessing most of the functionality available
in the computer loaded with Windows
a. Taskbar
b. Folders
¢. Start Button
d. Mouse
e. Application
ii. Control Panel allows you to customize which of the following feature:
b. Appearances
b. Themes
c. Printers
d. Other Hardware
€. All of the above
iili. * Computer virus is simply a
" adisease
set of computer instructions or computer code
type of bacteria
hardware component
none of the above
iv. Klezis a
Game name
Hardware component
. Virus name
Person name
None of the above
V. Good Times was a
virus
anti virus
fake news about the existence of virus
. none of the above

Q.11
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®H% - (ii) Name, Extension  (iii) Recyclebin  (iv) Windows Explorer

(v) Recycle Bin  (vi) Shortcut (vii) Virus (viii) Operating system

(ix) Antivirus  (x) Control Pane!

Q.12
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